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E-ORDERS INTRODUCTION

E-Orders is a web-based application developed by the U.S. Bankruptcy Court for the Western
District of Texas for electronically submitting, routing, reviewing, disposing, and docketing
orders in conjunction with CM/ECF. It is a fully integrated system that allows attorneys and
trustees to submit orders electronically and provides judges and court staff with the ability to
process and sign these orders. Among the obvious benefits of this integration, attorneys using
CM/ECF do not have to learn new software to submit orders to the court, and court staff can
handle motions and orders with the same program. E-Orders requires a minimal amount of new
data entry since it can access most of the pertinent case-related information (case title, related
document, description, etc.) from the CM/ECF database.

E-Orders was designed to be flexible so that courts can use its many features in a variety of
ways. For example, access to incoming orders can be easily configured, as well as the number
and types of “folders” where the orders are routed. The application has enhanced features such
as adding notes to alert the judge about problems or simple reminders and filters to select the
type of orders to review or sign. Security features are also present to provide levels of access to
authorized users and ultimately to prevent anyone but the judge from electronically signing the
orders. Also, there is a program feature for judges to handle and sign orders when covering for
a fellow judge. Signing orders is only one of the options available to judges once an order has
been forwarded to them. In addition to signing the order, the judge can decide to deny the
relief or render the order withdrawn or moot, in which case the application places a specialized
digital stamp, such as, “Denied for the reasons orally stated on the record at the scheduled
hearing date,” along with the judge’s electronic signature. This feature is flexible enough to
allow the judge to have multiple individualized digital stamps.

In addition, E-Orders has the ability to upload, route, and sign orders in batches. Chapter 13
trustees can upload a number of standard orders in batch. Court staff can review and route
these orders in batch to the judge for signature. The judge can then decide to sign these orders
in batch. For example, if your Chapter 13 confirmation orders are form orders and the real
review is done at confirmation, the judge can decide to sign a batch of these orders all with one
click. This can be a tremendous savings in time and effort.

Uploading orders into the E-Orders application begins the process. Orders can be uploaded by
two types of users—external and internal. The external users are the attorneys and trustees
that work with the court, and the internal users include all court personnel. Attorneys can only
upload orders one at a time. Chapter 13 trustees and internal users can upload orders in
batches, as well as one at a time. Orders can be uploaded in both bankruptcy cases and
adversary proceedings. The orders must be associated with a specific case and related
document except for batch and sua sponte orders, which cannot be associated with
a document. Sua sponte orders can only be uploaded by court users.

All orders must be converted to PDF format before uploading them into the application.
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E-ORDER PROCESS OVERVIEW

E-Orders manages order processing from the submission of a proposed order, to reviewing and
signing the order, to docketing and noticing of the order. The basic process is as follows:

* Proposed orders are uploaded into E-Orders by either internal or external users.
e Orders are then electronically routed and reviewed by the necessary staff.

® Once the order is ready for signature, it goes to the judge who can sign the order
electronically.

o After the order is signed, it is manually docketed by court personnel. A quality assurance
review is also incorporated into this step in the process.

e Lastly, the application administrator sets up and maintains the user accounts, security, and
access to the system.
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TECHNICAL REQUIREMENTS FOR E-ORDERS

Orders may only be uploaded in PDF or PDF/A format, and must contain a “.pdf” extension. No
security should be applied to the PDF file. It is highly recommended that orders be created
using a word processing application such as Word or WordPerfect and saved to PDF rather than
scanning a printed copy of the document. This not only makes the order more legible, but also
results in a text-searchable document.

Form orders published by the court must be “flattened” before uploading to lock in
information. “Print” to PDF - if your software does not have this capability, print the order on
paper and scan it to make a PDF file.

FORMATTING REQUIREMENTS (See attached order templates)

e Reserve the top 4 inches of the first page for the judge’s signature and any additional
text the judge wishes to add. All other pages of the order should have top and side
margins of one (1) inch.

e To assist the court in verifying that the entire body of the submitted order has been
properly transmitted, the last line in the order must consist of [END OF DOCUMENT] in
bold, upper case letters, centered on the page, one line below the end of the order’s

text. Any signatures and/or attachments will be placed below this line.

e Do not include a line for the date and signature of the judge. All orders will be signed
and dated electronically by the judge in the space provided at the top of the first page.

e |dentify the attorney who is submitting the order directly below the [END OF
DOCUMENT] text, to the left of the page by including a signature block as shown on the
attached proposed order templates.

e Attach any exhibits after the page with the [END OF DOCUMENT] notation.

e Orders should NOT include distribution lists or certificates of service.
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AP Order Template
4” margin required at top of first page.
Allow 1” for all remaining margins.

IN THE UNITED STATES BANKRUPTCY COURT
SOUTHERN DISTRICT OF GEORGIA

In the matter of:

John Q. Debtor

Chapter XX Case NO.  XX-XXXXX-XXX
Debtor(s)

Adversary Proceeding No.

Paula P. Plaintiff

Plaintiff(s)
VS.
Doug D. Defendant
Defendant(s)
TITLE OF ORDER
Order text. . .

[END OF DOCUMENT]

Prepared by:

s/Typed name of attorney (or scanned signature)
Attorney Name

Attorney for [Party Name]

Bar Number

Street Address

City, State and Zip

Telephone Number

(If consent is required)

Consented to by:

s/Typed name of attorney (or scanned signature)
Attorney Name

Attorney for [Consenting Party's Name]

Bar Number

Street Address

City, State and Zip

Telephone Number

XX-XXXXX
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BK Order Template
4” margin required at top of first page.
Allow 1” for all remaining margins.

IN THE UNITED STATES BANKRUPTCY COURT
SOUTHERN DISTRICT OF GEORGIA

Inre: CASE NO.  XX-XXXXX-XXX

John Q. Debtor CHAPTER XX
Debtor(s).

TITLE OF ORDER

Order text. . .

[END OF DOCUMENT]

Prepared by:

s/Typed name of attorney (or scanned signature)
Attorney Name

Attorney for [Party Name]

Bar Number

Street Address

City, State and Zip

Telephone Number

(If consent is required)

Consented to by:

s/Typed name of attorney (or scanned signature)
Attorney Name

Attorney for [Consenting Party's Name]

Bar Number

Street Address

City, State and Zip

Telephone Number
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SUBMIT (UPLOAD) A PROPOSED ORDER

Before beginning this process, please review section describing requirements for E-Orders.

To upload an order related to a bankruptcy case, open CM/ECF and click Bankruptcy in the
blue CM/ECF Main Menu bar. The Bankruptcy Events Screen appears.

NOTE: The process for uploading single orders to adversary proceedings is the same as
uploading to bankruptcy cases with the exception that the users should choose Adversary on
the CM/ECF Main Menu instead of Bankruptcy.

—
EE ' F Eankruptcy Adversary Query Reports Utilities Search Logout H

Bankruptcy Events

File Claims
Creditor Mainte
Order Upload

Click Order Upload and the Upload Type Selection screen appears.

Bankruptoy Adversary 2 Utilities

Order Upload for Bankruptcy

UPLOAD SINGLE ORDER

The Single Order Upload feature permits you to upload one order at a time. When you
select Single Order Upload, the following reminder appears. Click Next to continue.

EE C F Bankruptcy

#c &) | Docket Sheet Claims Register Maiing Matrix by Case Deadlines/Hearings Calendar Events[1772077 5]  Associated Cases ,"
Single Order Upload

Orders should NOT include distribution lists or certificates of service.
If your order includes such attachments, DO NOT continue with this upload.

Remove attachments and begin the upload process again.
| Next | | Clear !

Page | 6



An Enter Case Number screen appears for you to input the case number for the proposed
order.

EE ‘ F Bankruptcy Adversary Query Reports. Utilities Search Logout e

|Single Order Upload
|

Case number | 413 10009 Find This Case
Next Clear

After typing in the case number, click Next.

The Related Document Number screen appears.

—
EE ' F Bankruptcy Adversary Query Reports Utilities Search

|
Single Order Upload
3-10005-SDB John B Test

Related document number

MNext Clear

If you know the related document number, type it in the space provided and click Next. The
Upload a Single Order screen appears. If you do not know the number of the related
document, there are two ways to get the information. First, you can click the case number
hyperlink, which produces a docket report for the case. You should note that when clicking this
link, the PACER login page will appear since there are costs associated with looking at the
docket report. The second method is to click Next. A search criteria screen appears.

1
EE ‘ F Bankruptcy Adwversary Query Reports Utilities Search Logout e

Single Order Upload
13-10009-SDB John B Test

Select the category to which your event relates:

appeal A
auditor
caseupld
claims

cmp

court
crditcrd
misc

notice bt

Filed | ] to |

Documents

|Ne><t Clear
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The search criteria screen contains three selections. You must select a related document
category. Your selection will almost always be motion. Optionally, you can enter a filed date
and/or document number range to help narrow the search results. The dates are entered in
the following format: mm/dd/yyyy.

After you have made your selections, click Next.
A search results screen displays.

If the document your order relates to is not shown, click your browser Back button to return to
the search criteria screen.

—
EE F Bankruptcy Adversary Query Reports Utilities Search Logout 8
Single Order Upload

13-10009-SDB John B Test

Select the appropriate event to which your event relates:

[ 10/3072013 4 Motion to Make Direct Payments to Trustee Filed by James B. Duncan III on behalf of John B Test .
Attachments: = 1 Proposad Order) (Saul, Lainie)

11/01/2013 3 Objection to Claim Number 2 of Be
Responses due on or Before: 12272

ficial and Notice and Opportunity for Hearing. Filed by Huon Le
3. (Attachments: # | Proposed Order)(Saul-trustee, Lainie)

Change your search criteria for a wider/different search. If only one document is found, it will
automatically be selected for you. If the document appears in a list, click the check box to
select, then click Next. The Upload a Single Order screen appears.

—
| EE ‘ F Bankruptcy Adversary Query Reports Utilities Search Loge H
K n DoctetSnest  Ciaims Regler  Malling Mty Case  Deadimes™earings B i 0 j Aszorizeg Cases f

Single Order Upload
13-10009-SDB John B Test

|§elaled document number: 3

elated document description: Objection to Claim

Order | Ex Parte (No Hearing Required) v

npe Note: If tha related document is an amendment and the orisinal document has been set for a haaring then sslect order tvps of Hearing Schaduled

i Al O

Notes

Folder R4
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NOTE: The Notes and Folder selections only display for court users.
Confirm the Case Number, Case Name, Related Document Number, and Related Document
Description shown at the top of the screen. Next, select the Order Type from the drop-down

list. The Order Type selections are:

| Consent | Expedited | Hearing Held | Hearing Scheduled | Other |

If you select Hearing Held or Hearing Scheduled as the Order Type, you must fill in the Hearing
Date field. If correct, click Next. The screen to attach a PDF appears.

=
EE ‘ F Bankruptcy Adversary Query Reports Utilities Search Logout H

Single Order Upload

Filename

N-\PDF Files\TESTING PDF pdf

Attachments to Document: & No O Yes

Next

The Filename field is where you enter the path and filename of the proposed order PDF file.
Click the Browse button to locate and select the file. You can also type the path and filename in
the box. Please make sure the PDF file is correctly formatted - if incorrectly formatted the
order may not process correctly through the court’s noticing center. Finally, review all the
information carefully and if correct click Next. A submission confirmation screen appears. You
can view the uploaded PDF by clicking the hyperlink.

| EE F Bankruptey Adversary Query Reports Utilities Search Logout 4‘)

Single Order Upload
13-10009-SDB John B Test

The new document TESTING PDF.pdf was upleaded successfully on 11/1/2013 at 11:11 AM

Order type: Ex Parte (No Hearing Required)
13-10009-SDB John B Test

|§eln(ed document number: 3
elated document description: Objection to Claim
Order ID: 28

Do it again
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DEFECTIVE ORDERS

If a proposed order is found by the court to be defective, a text only Deficiency Notice (RE:
Proposed Order) will be sent to the submitting party. The notice will advise you
what corrections are needed and will instruct you to resubmit the order via the E-Orders
module. To resubmit, click on Bankruptcy (or Adversary) > Order Upload > Single Order
Upload, enter the same case number and related document number, and select replace the
order.

You must also file the corrected proposed order on the docket and serve the order on
appropriate parties using the event Bankruptcy (or Adversary) > Miscellaneous >

Proposed Order with Certificate of Service.

UPLOAD AN ADDITIONAL ORDER OR REPLACE AN ORDER IN UPLOAD SINGLE

In some instances an uploaded order may need to be replaced or a second order uploaded. For
example, the judge might direct an attorney to submit a revised order. The attorney submitting
the original proposed order can replace that submission with a revised order. An order cannot
be replaced if the original order has already been routed to the Judge. In this case, the
application will let you know the order cannot be replaced. You cannot replace an order
uploaded by a different filer.

The process of replacing an order or uploading an additional order is essentially the same as the
upload process described in this section. After selecting the document number a Replace Order
screen appears to let you know an order(s) already exists for this document number and gives
you the option to create a new order or replace an existing order.

™
EE ‘ F Bankrupicy Adversary Query Reports. Utilities Search Logce (’

‘ t n DoctstSnest  ChimcRegiswr  MaUPgMaTNmCae Dumoiwsveamgs j-J Azzosizme Cazes /1

|Single Order Upload

:\\'arning: The following order(s) already exist for the same case and related document.
Case Info Related Doc Order Notes
13-10009-SDB D3 28
John B Test Objaction to Claim By Saul-trustes, Lainis
Ch 13 Filed: 11/01/2013 11/012013

© Upload another order
@ Replace the order(s)
Replace the order 28

‘ Next Clear

Choose whether to add another or replace the current order by clicking the appropriate radio
button. If you choose to replace the current order, designate which order you are replacing by
clicking the check box next to the corresponding order number. You can click the PDF hyperlink
to review the PDF files to help determine the order to be replaced. You can check multiple
boxes to replace more than one order at a time.
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After making your selections, click Next.
The Upload a Single Order screen appears.
Add the necessary information the same way as in Upload Single. Then finish the upload

process as described. A confirmation screen lets you know the process was completed
successfully.

UPLOAD BATCH ORDERS (Trustees)

NOTE: There is no Batch Upload option for attorney filers or for adversary proceedings.

The Upload Batch feature allows trustees and court personnel to upload multiple orders at one
time. The application ensures trustees can only upload orders for cases assigned to them. You
must have the case number and PDF filename for each order before beginning the batch upload
process. Each batch uploaded must contain the same Order Type and Order Description for
each order in the batch. Trustees can upload orders with different descriptions to the same
case. After selecting Order Upload from the Bankruptcy Events screen, click Upload Batch on
the Upload Type Selection screen. An Upload Batch Orders screen appears prompting you to
enter the Order Type; Order Description; Hearing Date, if appropriate; and the Case Numbers.

=
| EE ‘ F Bankruptey Adversary Query Reports Utilities Search Loge (I
X n DoctatSneet  ClaimsReghetsr  MalnghakpyCxse Desgmestearngs o [11/172 j Associzted Caces f

|Batch Order Upload
Order type Other o

Order description | Order to Pay Wages i

Hearing date j

Case number(s) |;.13_pr-10001

The Order Types are the same as those listed in Upload Single. If you select the Order Type of
Hearing Held you must fill in the Hearing Date field or you will not be able to finish the upload
process. The Hearing date must be the same for each order in the batch.

Next, type in the case numbers related to each order in the format XX-XXXXX. Press Enter after
each case number to create a list of case numbers. There is no limit to the number of cases
that can be listed, but we recommend that you enter no more than 50 numbers at a time. (If
you make a mistake you will have to retype the entire list.)
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After typing the case number list, click Next.
The Batch Orders PDF Selection screen appears.

Bankruptcy

DoctstSnest  Claims Register  Maling Matrti oy Case  Deagines™earings reis 111 1 . Associmed Cases
) . ¢ Calengar Bierts -J

|Batch Order Upload

13-10007-SDB Karen B Test

Add main document

13-10010-SDB Laker Blue, ITT

[ Add main document J

@ Clear

For each case number, enter the path and filename of the proposed order PDF file by clicking
Add main document to locate and select the file or typing the complete path and filename in

the box.

=
EE ‘ F Bankrupicy Adversary Query Reporis Utilities Search Log
'K n DoutSnest  CulmsMoghter MalngMabyCaie  Dmalinesrearngs . o I 20 j Assoctated Cases ,;N

|Batch Order Upload

13-10007-SDB Karen B Test

Add attachment

[
File Name Category Description Size | Delete Status

TESTING PDF.pdf Main Document ~ N/A B Added to List

13-10010-SDB Laker Blue, ITI

Add attachment

File Name Category Description Size = Delete Status

TESTING PDF .pdf Main Document  N/A | Added to List |
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When all files are attached, click Next.

Review all information carefully. Once you click Next you will not have an opportunity to
modify the submission.

EE ‘ F Bankruptcy Adversary Query Reports Utilities Search Loge
K q Dosetseer  Clae Regir  MamngMavaDiCae  Dewersangs o [11172 __j] Ascociaed Cases /3\

Batch Order Upload

13-10007-5DB Karen B Test

Add attachment

File Name Category Description Size | Delete Status |
TESTING PDF .pdf Main Document = N/A [ Added to List |

13-10010-SDB Laker Blue, III
Add attachment
| File Name Category Description Size | Delete Status |

| TESTING PDF pdf Main Document  N/A B Added to List |

JAttention!! Submitting this screen commits this transaction, You will have no further opportunity to medify this submission if vou continue,

[Have vou redacted?

After you click Next, you will receive a confirmation screen. If you would like to view the
uploaded documents, click each new PDF file hyperlink.

Bankruptcy Adversary Utilities

K q oS ClameRegiser  Mallog vk Case  Desdimesvesigs -| 1111201 j Azzozizes Cases /?*

'iBatch Order Upload
The following orders were uploaded successfully on 11/1/2013 at 11:36 AM

|Order type: Other
(Order description: Order to Pay Wagss

13-10007-SDB Karen B Test

File Name Description Size Order Id
TESTING PDF pdf Main Document SKB 29

10-SDB Laker Blue 111

»

Description Size Order Id

Main Document SKB 30

Do it again

(2oL ain
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CHECKING THE STATUS OF A SUBMITTED ORDER

After uploading a proposed order into ECF using Upload Order, the status of the order may be
checked by using the Order Query option under the Reports Menu.

1. To query the status of an order, select Order Query on the Reports Menu.

2. If searching for a particular order that has been uploaded, enter the case number and
any optional parameters, and click Next.

Check Include proposed orders
Order Query w‘rhere no action was t.aken to
display replaced or rejected orders.

Case Number |1-13-bk-10009

M i | T o I - G| Check Include proposed ?rders that
have been docketed to display

Docket date | 4 to l i orders that have been signed and

Include proposed orders where no action was taken. docketed.

Inchide proposed orders that have been docketed.

Inchide proposed orders that are being processed. Check Include proposed orders that

are being processed to display

orders that have been submitted
and are awaiting review, signature
and entry.

3. When the case number selection is used, the report will list all orders that were
electronically uploaded, currently pending for that case.

Case Number x Related Doc# x Order x Type x Description x Submission Date x  Submitter x Status x
13-10007-SDB , , - No Action Taken
Karen B Test 29 Other Order to Pay Wages 11/01/2013 Saul, Lainie 11/01/2013
13-10007-SDB - No Action Taken
Karen B Test 3 Other Order to Pay Wages 11/01/2013 Saul, Lainie 11/01/2013
13-10007-SDB A 104/ : No Action Taken
Karen B Test 32 Other Order to Pay Wages 11/01/2013 Saul, Lainie 11/01/2013
13-10007-SDB ExParte (No y451i0n to Make Direct Saultrustee,  Bein

- 4 33 Hearing 11/01/2013 it ' 9
Karen B Test Required) Payments to Trustee Lainie Processed

4, If the case number is left blank, all pending orders that you have uploaded will appear.
Case Number x Related Doc# x Order x Type x Description x Submission Date x  Submitter x Status x
Sqoktcﬁe;n'l‘mj 36 538 Other vg:sg f'g r‘”;‘;;‘aigigge °f  o6/19/2014 E:i%':mmey' Being Processed
T:ml:ir?y? ggfﬁnns and 272 Other Motion for Relief From Stay  03/06/2014 et bl
Denise Audrey Hillis
,;«:n_:.; %Ddbfifa%a Annie Rubin 7 271 Other  Motion to Borrow 03/06/2014 fg;’;‘mmey B"gég}‘z‘%ﬂake”
o 15 662  Other  Mofion to Close Case (Ch 11) 10/02/2014 paniaHomeY.  peing Processed
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An order uploaded into ECF using Order Upload, will be on this Order Query Report with
a Status of Being Processed from the time it is uploaded until it is signed by the
judge or has been routed to the Trash folder. Therefore, if you have uploaded an order
and it is no longer on the Order Query Report, it has either been signed by the judge or
has been routed to Trash. If the order has been signed, you can obtain a copy of the
signed order from the docket after it has been docketed. A signed e-order will be
docketed by the close of the next business day after it has been signed. So if your order
is not on the Order Query Report and is not yet on the docket, you should check the
docket at the end of the next business day. You will not be able to locate a signed order
until it is docketed. If the order is not on the Order Query Report because it was sent to
the trash folder, you should have been notified of that.
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HOW TO SET MARGINS IN WORD

Word 2007 / 2010 T ——

To set the top margin of the first page of your proposed order to 4

Last Curtam Letting

inches:

i

1. Place the cursor at the top of the first page (Ctrl+Home).

Click Page Layout>Margins>Custom Margins. 8] ® k"
3. Inthe Page Setup Window, type “4” into the Top Margin input .
box.
4. Click OK.

" 3 I |

To set the top margin of all other pages to 1 inch:

1. Insert a continuous section break. __=

a. Click Page Layout>Breaks>Continuous.
2. Change the top margintolinch. ~—°
a. Click Page Layout>Margins =
b. Select desired setting with 1 inch top margin (Normal,

Narrow, Moderate, etc.) or set with custom margin.

HOW TO SET MARGINS IN WORDPERFECT

WordPerfect (any Windows version)
To set the top margin of the first page of your proposed order to 4 inches:

1. Click Format>Margins in the toolbar or press Ctrl+F8.

2. A new window will open with the four margins listed (Left,
Right, Top, and Bottom) with a default of 1”.

3. Type “4” into the Top margin input box.
4. Click OK.

To set the top margin of all other pages to 1 inch:

1. On second page of document, repeat steps 1-4 above, but
change top margin to 1”.
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HOW TO FLATTEN A PDF

Certain versions of Adobe Acrobat and other PDF editing software are known to cause serious

document image quality issues when a PDF file is electronically filed through CM/ECF. As a
result, all PDF files must be “flattened” before filing through CM/ECF. Flattening a PDF file may
also reduce the file size of a PDF fillable form by up to 90%, conserving valuable resources for

the Court.

Instructions to Flatten a PDF File:

e Create a PDF document for filing as usual

e From the Print feature, select Adobe PDF as the printer (see print screen)

e Select Print button at the bottom of the screen.

e Name the document and select Save.

e Upload the document into CM/ECF using normal procedures.

Print

Prigter: | Adcbe POF -l ——rrmertiey—- v

HP L] P401 4 Series POL &

Microsoft XPS Documert: Writes

Pages |HP Colar Lasardet CM2320 MFP Senes PCL 6 Comments & Forms

Copies:

Document and Markups
Summarizs Commenks

» More Options 8.5 % 11 Inches

Help
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[ Es{ze H a?mea | | E Multiple J | E Bocklet ]
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(s 4
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Orientation:
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